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Operating Systems

The operating system is the core software component of the computer. It performs many functions and is,
jn very basic terms, an interface between your computer and the outside world. In the section about hard-
ware, a computer is described as consisting of several component parts including your monitor, keyboard,
mouse, a“?,‘ other parts. The Operating system provides an interface to these parts using what is referred to
as “drivers”. This is why sometimes when you install a new printer or other piece of hardware, your system
will ask you to install more software called a driver.

WHAT DOES A DRIVER DO?

A driver is a specially written program which understands the operation of the device it interfaces to, .

such as a printer, video card, sound card or CD ROM drive. It translates commands from the cperating sys-
{em or user into commands understood by the the component computer part it interfaces with. It also irans-
lates responses from the component computer part back to responses that can be understood by the operat-
ing system, application program, or user. The below diagram gives a graphical depiction of the interfaces be-
tween the operating system and the computer component.
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OTHER OPERATING SYSTEM FUNCTIONS .
The operating system provides for several other functions including:

é System toois (progranié) used to monitor computer performance, debug problems, or maintain parts of

the system.

© A set of librarles or functions which programs may use to perform specific tasks especially relating to

mponents.

' th computer system co

m?t:ﬁac:?gg‘gyatem :;akes these interfacing functions along with its other functions operate smoothly
. operatin, | 2

these furictions are mostly transparent to the user.

) : ONCERNS :
pﬁmuoi Y:TESI::::: is a computer program. Operating systems are written by human programmers who
A1 operating sy

be errors in the code even though there may be some testing before the
e mistakes, Therefore there can
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es in the fact that not ag

[ciesa]
product is released. ;
ware quality contr ‘;’ evels of quality from operating sys-

anies have better soft-
: s::g tc:;?iﬁg than others so you
: 4 Eﬁf Eogg:ft:nyf;system. Errors in operating systems
i cause three main types of problems : .
L System crashes and instabilities : t’}rq?;ejeerat_
happen due to a software bug typically lrllne o rﬂ orat
ing system, although computer programs g on
the operating system can make the gystem more u
stable or may even crash the system by themselves.
T':is varies depending on the type of operating system.
A system crash ts the act of a system freezing and be-
coming unresponsive which would cause the user to
need to reboot.

Security flaws : Some software errors leave a door
open for the system to be broken into by unautho-
rized intruders. As these flaws are discovered, unau-
thorized intruders may try to use these to gain illegal
access to your system. Patching these flaws often will
T help keep your computer systern secure.

i e e

Sometimes errors in the operating system will
cause the computer not to work correctly with some
peripheral devices such as printers.

OPERATING SYSTEM TYPES

There are many types of operating systems. The
most cornmon 1s the Microsoft suite of operating sys-
tems. They include from most recent to the oldest :

Windows XP Professional Edition : A version
used by many businesses on workstations. It has the
ability to become a member of a carporate domain,

Windows XP Home Edition : A lower cost ver-
sion of Windows XP which is for home use only and
should not be used at a business,

i Windows 2000 : A better version of the Windows

. J NT operating system which works well both at home

i and as a workstation at a business. It includes tech-

1 nologies which allow hardware to be automatically
detected and other erhancements over Windows NT,

Windows ME : A upgraded version from wind
98 but it has been historically plagued with prolérgrwns-;
i mingw:-:rs ngch may be frustrating for home users,
y ows 98 : This was produced ‘
i Produced in two main vey-
I sions. The first Windows 98 version was plagued wfth

Windows NT : A version of Windows mﬁd

cifically for businesges offeting better contro} mrﬁvzﬁ:

statlon capabilitiea to help network admintstrators
Windows 08 | The firat vers

the older Windows 3.x veraiong igﬁ i, Indowa after

erin ‘ in-
terface and better library functiong for p%n:rmfr .
worthwhile types of operating
Mleme_o!t. The greatest preblen% v:r{tah

 these operating systems Ii
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many application programs arc written for them. How.

| ever if you can get the type of application programs

you are looking for, one of the systems listed below

may be a good choice.

Unix : A system that has been around for many
years and it is very stable. It Is primary uslflg tobe a
server rather than a workstation and SE]M;h not he
used by anyone who does not u.nderstan e system,
It can be difficult to learn. Unix must nonnthaﬂy run
an a computer made by the same company that pro-

duces the software. o
v ‘ in operation but

Linux : Linux is similar to Unix
it is free. It also should not be used by anyone who
does not understand the system and can be difficult

to learn.

Apple MacIntosh - Most recent versions are based
on Unix but it has a good graphical interface so it is
both stable (does not crash often or have as many
software problems as other systems may have) and easy
to learn. One drawback to this system is that it can
only be run on Apple produced hardware.

KERNEL

In computing, the kernel is the central component
of most computer operating systems; it is a bridge be-
tween applications and the actual data processing done
at the hardware level. The kernel's responsibilities in-
clude managing the system's resources (the communi-
cation between hardware and software components).
Usuallyr as a basic component of an operating system,
a kernel can provide the lowest-level abstraction layer
for the resources (especially processors and I/0 de-
vices) that application software must control to per-
form its function. It typically makes these facilities
available to application processes through inter-pro-
€ess communication mechanisms and systern calls.

. In most cases, the boot loader starts executing the
! ernel in supervisor mode, The kernel then initializes
tself and starts the first Process. After this, the kernel

nel procesg manage
men :
ardware buﬂt-l:gequi Soniat |

To run an application
» 4 kerne) 81
an address space for the application, tmﬁﬁg gﬁ‘.t:‘;:‘p
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taining the application’s code iﬁt& memory [perhé

] ps
wa dqmand paging), sets up a stack for the program
md‘branches to a given location inside the program,
thus starting its execution,

Multi-tasking kernels are able to give the user
jllusion that the number of processegis being runt:i?
multaneously on the computer is higher than the maxi-
mum number of processes the computer is physically
able to run simultaneously. Typically, the number of

processes a system may run simultaneously is equal
to the umber of CPUs installed .

The operating system might also support mult-
processing in that case, different programspapi'ld thr:;ds
may run on different processors. A kernel for such a
system must be designed to be re-entrant, meaning
that it may safely run two different parts of its code
simultaneously. This typically means providing syn-
chronization mechanisms (such as spinlocks) to en-

sure that no two processors attempt to modify the same
data at the same time.

Kernel Memeory management: The kernel has full
access to the system's memory and must allow pro-
cesses to safely access this memory as they require it.
Often the first step in doing this is virtual addressing,
usually achieved by paging and/or segmentation. Vir-
tual addressing allows the kernel to make a given physi-
cal address appear to be another address, the virtual
address. Virtual address spaces may be different for
different processes; the memory that one process ac-
cesses at a particular (virtual) address may be differ-
ent memory from what another process accesses at the
game address. This allows every program to behave as
if it is the only one (apart from the kernel) running
and thus prevents applications from crashing each
other. :

Kernel Device management: To perform useful
functions, processes need access to the peripherals con-
nected to the computer, which are controlled by the
kernel through device drivers. For example, to show
the user something on the screen, an application would
make a request to the kernel, which would forward the
request to its display driver, which is then responsible
for actually plotting the character/pixel. A kernel must
maintain a list of available devices. This list may be
Kknown in advance (e.g. on an embedded system where
the kernel will be rewritten if the available hardware
changes), configured by the user (typical on older PCs
and on systems that are not designed for personal use)
or detected by the operating system at run time.

MULTITASKING

In computing, multitasking 18 & method where
multiple tasks, also known as processes, shate come=
mon procensing resources such as o CPU. In the case
of a computer with a single CPU, only on¢ task is said
o be running at any point (n time, meaning that the
CPU fs aotively executing instructions for that taak,
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Multitasking solves the problem by scheduling which
task may be the one running at any given time, and

| when another walting task gets a turn. The act of re-

assigning a CPU from one task to another one is called
a context switch. When context switches occur fre-
quently enough the illusion of parallelism is achieved.
Even on computers with more than one CPU (called
multiprocessor machines), multitasking allows many
more tasks to be run than there are CPUs. For ex-
ample, when you see someone in the car next to you

| eating a burrito, talking on his cell phone, and trying

to drive at the same, that person is multitasking.

Multiprocessing : A computer processing mode
that provides for simultaneous processing of two or
more programs or routines by use of multiple CPU’s.
Multiprocessing is the use of two or more central pro-
cessing units (CPUs) within a single computer system.
The term also refers to the ability of a system to sup-
port more than one processor and/or the ability to
allocate tasks between them.

APPLICATIONS
WHAT IS AN APPLICATION

Applications are programs that are installed on
computers to give users the ability to do spectiic tasks.
For example, Microsoft Word® is a program that gives
the user the ability to write documents. Some program
packages come in a set with multiple programs in-
cluded to provide multiple capabilities such as the
Microsoft Office® suite of programs. This suite of pro-
grams also includes Microsoft Outlook® which s used
{o send and receive e-mail. It also includes other pro-
grams with more capabilities.

HOW APPLICATION PROGRAMS WORK

. Application programs are writien in a text based
computer language as mentioned in the section about
hardware and software. Once written, they are com-
piled into a binary language the computer under-
stands. The application programs use function calls
to interface to the various computer peripherals such
as your keyboard, mouse, screen, printers, and other
devices. Most of these function calls are provided by
the operating system so the application programs are
usually compiled for a specific operating system such
as Microsoft Windows 2000®, Microsoft Windows
XP®, or Microsoft Windows 98®.

Application Problems : An application program
{s a computer program. It is written by human pvo-
grammers who make mistakes. Therefore there can be
errors in the code even though there may be some test-
ing before the product is released. Application pro-
grams vary widely in the quality of the code. Errors
in code are referred to as "bugs”, Bugs can cause un-
predictable results including systemn crashes, inubll-
ity to perform expeoted functions, or providing an ex-
ploit for an attacker who wants to gain control of your
system. Bad Applications
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~ grams, Some applications

' Thgre are many types of applications that can
.cause problems on your computer system.
¢  Applications with serlous bugs. , 4 oro-
Applications that come with unwante pnﬁ-
come with additio;s;ll fi by
e t but is instaile
e that you may not really wan
g:r&mlt. Ns::ormally this is only annoying ag;lc:-la;g
slightly slow your system down-when it bmtstart use
some ot these items will load every time you start y
computer. .
Advrare : Most adware comes with programs tha
may be purchased or downloaded for free on the
internet. Adware will cause advertising popups to ap-
pear nn your computer. Besides being annoying, they
will slow your ability to access the internet. Many
Himes these programs will download other ad programs.

These programs are very difficult to remove from your |

system because they are usually hidden on your sys-
tem very well. Many times it requires an expert to re-
move these programs but later I will give you some
Hps on how you can either remove them or render
them ineffective, but to be able to do this you must
have reasonable knowledge about your system.

Spyware : This usually comes with some free pro-
grams and it will monitor your internet activity and
send information to some corporation. This type of
Pprogram is not normally seriously harmful but most
people do not want to have their activities monitored.
There are also programs to remove spyware but it is
best to not install it in the first place,

FILENAME

A filename s a text string that identifies a file.
bvery file stored on a computer's hard disk has a
filename that helps identify the file within a given folder.
Therefore, each file within g specific folder must have
a different filename, while files in different folders can
have the same name, )

Filenames may contain letters, numbers, and other
characters. Depending on the operating system, cer-

tem, Different operating systems algo have diff
itmits for the number of charactersa filename cggf ;l;zr:
While older operating systems limited filenames to only
B or 18 characters, newer OS's allow filenames to be
u8 long as 256 characters, Of course, for most prac-
cal purposes, 16 characters is usually enough,
Filenames algo usually include a file extension,

which identifies the e of file,
O, et type of file. For example . txt, .exe,

7 PPLICATION FILRS
Applications have

hrea basie purposeg,
& Executable files
" Configuration filey

8 variety of files they use for
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WHAT FILES ARE
Files are a collection of data onto a permanen;

are stored on a permanen;
storae ?n#::!fgl :ﬁcnmg a computer hard drive, cp
Btoragdiive floppy disk drive or sometimes even-a tape
. Fﬂéé take a certain amount of room to store,
g:: g;:ample if you have two text files and one file hgg
one sentenice in it while the other file has 200 gep.
tences in it, the file with 200 sentences will use more

room: on the storage media.

| FILE FUNCTIONS

ve different purposes. Files are
user;j :gfir: r{l)tnil 1;? £§re of the following functions :

o Provide machine executable code which is used
to run application programs and the operating
system.

o Store application program or operating system
configuration information. ‘

@ Store data used by the user such as Microsoft
Word document files.

Therefore there are three types of information that

files contain :

@ Executable code,

@ System or program configuration information.

@ User data. _

These files are read by an application program or

the operating system, File Characteristics

Files have the below characteristics:

¢ Name

© Optional extension name - Part of the name,
1t is used by Windows operating systems to
{dentify an associated program that can be used
to read it

o ;8::: éShOWS vtﬂe Space the file requires for
age normally showed | Kb
which is 1000 bytes " Kilobytes ()

© Type - Indicates the "
the file, Program used to access

© Date Modified - Showg th le
Was created or changed, © last date the f

° :;110 SLrUCtUre - This characteristic is not view-
able by the computer uger but some programs

ne file structure to determine the type

:il;:g;ejlt. 18 even when the file extension 18

The main
all file t!;lfn it:en:: 0 remember incliude the facts that

the only way to determine

Ifyou are browsing ] ompy
£ on “Viewn = Jour files using “My Computer®
and click on View" and “Details” ;kolﬁ wxi‘tr see a wine

8¢ ===
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dbw showing the file characteristics like the one be-
. Jow. Folders only take a little room on the hard drive
and do not normally take as much room as files,

FILE TYPES

Because files can have different purposes,. they
have different types. The file type is best identified by
its file structure. For example a text file would have
a very different structure than a file than can be ex-
ecuted. An executable file must have a specific struc-
ture to be able to be run. The file structure is used to
determine its MIME type. The word MIME stands for
multipurpose internet mail extension and is used as
a standard to identify various file types. |

FILE EXTENSIONS

In operating systems such as Microsoft Windowr
systems, Linux, and Unix, a file extension is used t
help identify the type of file. On Microsoft Window
gystems, many file types are associated with a par
ticular program which can read the file. For exampl
a file with a .pdf extension can be read by the Adob
Acrobat application program.

Files are actually identified by what is called a

' MIME type. This can be done bec};use files that are

executable have a different structure than a data

structure. Therefore file extensions are not the only

way to identify a file type nor are they the most

accurate. Apple MacIntosh computer systems do
not use a file extension to identify file types.

EXECUTABLE FILE TYPES

The most important file type to be aware of are
executable file types. This is because if you acciden-
tally run an executable file on your system, it may
install a virus or some other unwanted software pro-
gram. Executable file types include:

@ .com ® .exe

FILE MANAGEMENT °
FILE, ORGANIZATION

Files can be placed in folders similar to the way
single sheets of paper can be placed into folders in a file
cabinet. Folders can be created on the hard drive or nested
inside each other any way the computer user desires.

Browsing Your files using Windows : If using a Windows operating system double click on the “My Com-
puter” icon on your desktop. A window like the one shown below will open.

= z TRT Ty
_ o :_I@ Go 'r\largon"’nn'l:"i'-#i'r.us E
Neme £ .. [Tope o o | — Towlsee]  FeeSpae] .
. 24314 Floppy (A1) 3%-Inch Floppy Disl )
i N T ELocal Disk (C:) Local Disk 7.772.GB 1,32 GB
1 My Computer EDLocal Disk (D) Lacal Disk 12.6 GB 1,90 GB
‘ : &) compact Disc {E:)  Compact Disc
Select an ftem ko view its description. @Compact Disc (F;)  Compact Disc
oo s o+ et (=2 Control Panel * System Felder
Displays the Files and folders an your
computer
1 see alsor .
My Documents
- My Network Places _
i Netwark and Djal-up Connections |

n the window shown
SYStgehigrsg ggx ;:beled as drive C. The
Rormal getup on most systems but I like to us
drive that holds the operat
Tead/write drive.
The drive letters will

ve any network drives. I
Your ﬂlez. This 18 because files on network

. ﬁleg are not backed up and your h

L,

ing system. Drives E and F are comp

véry depending on how you ‘
k drives, you should us
£ you o b or ngri:g; are usuai’ly backed up nightly in most qrgamzations. If your

ard drive fails, you will lose your data,
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s a floppy drive. It is labeled as drive A. The second disk is the
third disk shown is a data disk shown as drive D. This is not a
e a hard drive to hold my data that is different than the hard

act disks (CD ROM drives) of which one is &

r system is configured and depending on whether you

e them for the mail place you store
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SUBDIRECTORY

A file system (often also written as file system) is a
method of storing and organizing computer files and
their data. Essentially, it organizes these files into a
database for the storage, organization, manipulation,
and retrieval by the computer’s operating system. The
file system allows you to create new files and folders,
which are added to different parts of the "file tree" on
your hard disk.

For example, your hard disk probably has sepa-
rate folders for programs, documents, pictures, music,
and movie files. Within these folders, there are likely
other folders that further organize your files. All thege
folders {or directories) are organized by your computer's

file system. There are also several folders your |

computer's operating system uses to store system files,
such as start up data and system preferences. Some of
these folders are invisible to the user, but are recog-
nized by the computer's file system. |

DIRECTORY

A directory is another name for a folder. |
your hard disk are organized into various folEE:: c::;
directories, so that it ig easler to keep track of th::m.
For example, you may keep your pictures in one folder
and your music files in another folder, Folders can algo

contain other folders, allowing for mo
nization,

re specific orga- |

| Computers store data
SR = || in a series of directories,
e gk W, Pyt Joos HB, T G || Each directory, or folder,
s 15| Qoo (b G ==/l may contain files or other
ess (22 Lol Dk (C) s T ;120031101 po ' —1| directories. If a directory ig
. T gt Y T e RSO 16 ) .
i %IJ “Eﬂ?ﬁ_@ Fle Folder 3/27/2003 4:09 AM located MFhll? another dj.
2= E | i3am Fle Folder 1/10f2n04 7:41 P rectory, it is called g
Local Disk (C:) gﬁmf‘w and5... Fils Foider 3;::"2002:::22:: . subdirectory (or sul;folder}
| ; Fil Folder : ’ that older
; -+ {CaMy Music 2/17f2004 4158 PM o] of '
dton " |Cprogram Fes ;‘:;ﬁj 1/3/2003 8:58 AM ‘|| Subdirectories may refer to
it'él"f““m Fie Fokder usrzwa#:s“”"m folders located directly
1 Copacty:7.77 68 STERRA ' 2{13/2004 4:20 P . _
03 Used: 644G .‘mmmm Emii 1/3/2003 2141 AM | within a folder, as well as
N | (R Fle Folder 1452004 9:16 AM || folders that are stored in
O Free: 13268 . [Pamepzo0z File Foldes 11/25/2083 Z:t});‘ Po other folders within a folder,
| unoped 147
: gwm 3::35: :ﬁﬁﬁgf§=§apn For example, the main di-
) adobeweb.tog 0KB Text Document 2J8f2003 9:40 AM rectory of a file system is
. ke M7KD  Appication ;ﬁ;’igﬁ;:ﬁﬂ: o the root directory. Therefore,
R K8 Appication !
%ﬁ'mﬁ% mgm :\';F-loosaatdwﬂta 1/3{2003 2:28 AM { all other folders are
: =l Eboot LB _Configuration Settings _1/2/2003 9:19 Pit 2l subdirectories of the root
Focbject(s) - B e RS MY Conptor 4] folder.
FILESYSTEM COPYING FILES

" There are several ways Windows operating systems
allow files to be copied or moved. They include :

Drag and drop : In the window above it is easy
to drag one of the files into one of the folders. This
will move the file into the folder. This can also be done
by opening two windows using the "My Computer”
icon and dragging the file from one window to another.

Copy and paste : You can open a “My Computer”
window, and do the following:

© On the "My Computer” menu select “Edit",
then “Copy”,

© Navigate to the location where you want to put
the file. You can navigate by using the “Up"
folder to go Up one level into the folder struc-
ture or by double clicking on folders to enter
Ehem, If the “Up” folder does not exist in your
"My Computer” window, on your menu, select
View”, then “toolbars”, then select “Standard
Buttons",

© On the “My Computer” menuy select “Edit",

then "Pagte” The file |
. will be copied to the lo-
cation you haye navigated to. ?

thati:g}:ng Multiple Fileg ; There are several tricks
that eame used to make copying or moving multiple
pres easier. They tnvolve the selection of the files to

¢opled or moved, Yoy can hold down the Shift key

and select one fila by cli
- cking : ot
button (calleq left clicking), it With the left mous
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" down on the list, This will cause all files from the first

one. through the last one selected to be highlighted |
and selected. Release the Shift key. After this, you can L
hold down the Ctrl key and by left clicking on any @ Deglop e e
other files, they can be either selected or de-selected. ; ﬁw i -conienl o desKleg T
Release the Ctrl key. Once you have selected the files | & |~ - s-e_ — ‘dém-d efmp’ _ o
you can move them by dragging and dropping them | ' CwebVisw——ins IR
(after releasing both the shift and control keys) into | B & Enabla Web camenrﬁ folders
another folder. This is done as follows: | B2 47 UseWindows classic folders
1. Put the mouse cursor over one of the selected files. kN 4Brong:Foldei; N .
2. Left clicking the mouse and hold it down iK % 4 Opan each older in the sape window
" Dpen sach folder in its own window .
3. Drag the file to the desired location such as a n = - ' l
folder icon. ...~ Click items as follows - =
‘ ) o] TR A{” Single-click to open anitem (point to selact) . :
4. Release the left mouse button., : F‘Undﬁ:_Iinve.f_ic:_q‘ri"t'llles'c._nnsi';lent wilth my browser : SR
If you want to copy the files : RS I ,,'C",,Undelline.iﬁbﬁ litts only w}{en’lgo_fnt. atthem i
. e "5 Double-click to-open anitem (single-click té select] ‘ i
1. On the “My Computer” menu select “Edit", then | e - e — ‘ 1
“Copy™. . L A . R Hestore Defaults | ;
2. Navigate to the location where you want to put | - e — i ‘
the file, : o [o&T [ cencel | s |

3. On the “My Computer” menu select “Edit”, Click on the view tab and the dialogue box will b
then “Paste”. The file will be copied to the lo- change as shown below :

cation you have navigated to S oy I
VIEW SETTINGS .
The Default Windows Setting is Dangerous : i A E,
Windows systems come with default file view settings. ;- :'{Y.’bu'l:an set allof ygur.folders to the same-vigw..” -
] " for known file e e AV
The default is to "Hide file cxtensionsf 0 Tt b Boei A Fobies ‘
types”. This setting can be used to decieve a computer R i i) /i : ¥
user into believing that a file is safe to open when it — T ;
is not. Files containing viruses can be sent to a com- e B R T & b
' “ txt.exe” which is a 2] Files-and Folders ] = | 3
puter with the name “document.txt.ex [C] Display compressed fllas and folders with altemate color - §- |
file that the computer will run. The file will appear [0] Display the full path in the address bar g F g
to the computer user as sdocument.txt” making the " [ Display the full path in title bar :
t if the user Hidden files and folders e .

user belteve that it is safe to open, bu " ® Do not show hidden files and folders :
clicks on it the file will be run and be able to infect O Show kidden files and foldass .
[¥ Hide file extensions for known fite types ' v

the computer. " [ Hide protected operating system files (Recemmended) 5
Changing the View Settings : Open My Com- [0 Launch folder windows in a separate process i i

" wp A " ; | - [¥] Aemermber each folder's view sellings ’ ;
puter” by clicking on the “My Computer” icon on your . :
deskto::y Click on the menu item “View" and select’ Shogn..g._lfllg Documents 9".":‘," Desktop . ' =i :
“Details” from the drop down menu. This will change Co Restore Defaults |
the current settings for the folder or location you ar¢ PO ‘
in, but the change is not permanent yet. oK I Cancel } arp | S

To change the file view settings, if you are using.

Windows 2000 or XP click on the menu item “Tools” Click on the bgt}gn in ﬂ:ie chgg V;:W‘jh gz:}i‘g 3
and “Folder options” selectton. If you are using Win- | S2ys Like current lo ‘efalf? " ;m to 15; ieh the cur 3
: . . » A dia- | if you want to change olders B 3
~ dows 98, click on “View", and "Folder optlons rent folder. Change the rest of the settings 10 maiva

logue box similar to the one below should appear. the dialogue box as shown below :
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: chenma!dmzo!dmtu&mamm ;
[ e SRRSO [ 2
; FTko CaremFokdes || . ResslAlFodess | - [
% e , e .
¥ .
él Advanced settings:
: Files and Folders it
55 4 [ Display comptessed ffes and folders wih altemate colot A :
E 1 [ Displaythe hull path in the address bal -
.1 [ Dirplaythe hul pathn tide bar
x Hidden files and foldess
| ©® Donot show hidden fles and folders
] O Show hidden fies and folders
] [ Hide fle extensions for known file types :
! [4 Hide protected operating system fles (Recommended)
3 Launch folder windows in @ separate process "—ij
t 1 [ Remember eachlolder’s view selings i
R | Show My Documents onthe Desktop o :_I
;i : " Restore Defauls ] ) ‘
r: H s . - N . - N : _.:v o ~ I{
E 0K | Cancel | g |

The first three selections are display settings which |

make it more convenient to navigate through files and
folders. Be sure and uncheck the checkbox next to
“Hide file extensions for known file types”. If you are
using Windows 2000 or Windows XP, this should be
done for every user that logs in since each unique user
that uses the machine will get their own desktop and
.user profile,

FILE BACKUPS
Flle backups are very important to protect your

data. Is your hard drive fails or your operating sys- |

tem malfunctions, you could loose all your data. If
you do regular backups, you will drastically reduce the:
data loss that could occur, . '
Using the Network for Backups : Backing up
JYour data is very important, If you are operating on a

‘corporate or organizational network and have disk
Adrives shared from a file server it is likely that files

stored there are backed up every night. If possible '
. | . ou
should store your files on this server. F Y

Since Wind

"My Documents”
played from the
dialogue box simi-

Pl
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TR SR thelarget
. The My Decuments foldst ISE!shﬁlﬂi?l:IF to 8 targ 1
g r_;{::'lderilb'cation' shewn b?"f'w- Ll -

_T;ﬁtégt-faldér'.fdbation — - ) AT ! -»
a;géti‘. '.},,TC:i\DU‘cuments and Settings\Me\My Documentls 1 )
b " Find Target... l ] _
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7 Click on the “Move" button. A dialogue box simi-
lar to the one below will appear.

;e
. El My Computer
H EI@SI 3% Floppy (a:)
~-@ Local Disk (C:)
'-E Local Disk (D:}
El@ Compact Disz ()
‘ l@ Compact Disc (F:)
=-Ef My Network Places

b

Folder: |‘.‘Mv 60tuments | — — —
o _ ' ___Cancal" | I NawFDHNJ

Expand the "My ¢ . "
the + next to i, Thy omputer” object by clicking

en select the apprao riate network
drive that is best to put your doculi?rll)eng in. :

edge e
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How to BaCkup Data if You do not have a net-

| _lf you do not have a network and only have é

single computer you should periodically back up your

data. You should purchase or own one of the follow-

ing: ’

o Aread/write CD ROM or DVD drive

¢ A Zip drive

© A tape drive - Usually these are more expen-
sive.

You should be aware of where you store your files

and you should also know ‘where your mail files are

stored by your mail program such as Outlook or Qut-

look Express. If you right click on your inbox folder

in Outlook Express you can find the location where

your mail is stored,

INTRODUCTION OF MS-DOS

MS-DOS is an operating system initially developed
by ‘Tim Patterson” and he later sold it to Microsoft
Corporation.

MS-DOS is abbreviation of Microsoft Disk Oper-
ating System. It performs various tasks listed below—

{a) Control the processing of every application pro-

gram such as Word, Excel and others.

(b) Manages the files created on system.

(c) Displays the information on screen

Booting : Process that starts up a computer is
called “Booting”. After we switch ‘ON’ the power, it
checks for the proper functioning of all the periph-
eral devices attached with the computer.

It searches for the operating system, when located,
loads it into main memory. Booting is of two types—

Cold Boot : Firstly the memory and the peripheral
devices are checked before loading the operating sys-
tem. ' ' o

Warm Boot : Performed by pressing “Ctrl+Alt+Del”
key simultaneously. Memory and peripheral devices are
not checked in this case. The operating system is di-
rectly loaded OR we can say that when we are work-
Ing in an application and that software not running

OR the computer hangs then we prefer Warm Boot by -

Pressing “Ctrl + Alt + Del” to escape from the prob-
lem, By this the software that causing the problem
to user wiil stop running and system starts again.

- COMPONENTS OF MS-DOS

It consists the following ;
¢ Boot Record

V7 e10. sys
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° MS DOS. sYS

¢ COMMAN.COM

Boot Record : This term indicates the ‘start up’
of computer when we boot computer it means we turmn-
ing it ON and loading the operating system into our
computer’s memory.

I0. 8YS Program : This program interacts between

ch-m I

the computer's ROM (Read Only Memory), BIOS {Ba-

sic Input Qut-put Services) and MS.DOS sys.

As its name indicates it is an program of Input/
Output control. It controls the operation of keyboard,
screen, printer, disk controller and system clock.

The final task performed by it load the command
processor program i.e. COMMAND.COM.,

MSDOS. 8YS Program : It interacts directly with
the application program and 10.sys prog,

COMMAND. COM PROGRAM : It i1s also called
comumand-procesaor. It {s a user system interface. Some
of the commands of MS-DOS are defined in this file
and they are loaded into the memory along with this
file.

So, let us proceed to MS-DOS commands and they
are :

© Internal Commands

. © External Commands

We can consider the term “command” as a key to
perform a specific function OR

The order {command) of the commander to com-
mand his soldiers.

INTERNAL COMMANDS ‘
The command which are defined in the
command.com are :
© Very fast
@ Stored in RAM (Random Access Memory)
o Always available even if no such file name or
directory exists on the disk.
EXTERNAL COMMANDS

The commands which form part of the MS-DOS but
are not present in the system. Before an external com-
mand can be put to use, it has to be firstly loaded.

‘ © Slow in comparison to internal commands.
© Not stored, have to loaded before use.
@ Not available, we have to give the complete path
of the file, where it is present.

o If an external command is not present then
DOS gives an error message of “bad command

or file name”.
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e : disk drive to hej
| @l s Rt e »
. or more files.
Command  Description del Deletes one mmand that del
: - > al de ‘
L s MS-DOS to look in other direc delete Recovery consol‘e co eteg
append ~ Cause file or running a :
tories when editing a . a file.
command. deliree  Deletes one or more files or directories,
e
< mla-
arp Displays, adds, and removes arp info a4 List the contents of one or more direc.
tion from network devices. ory
assign  Assign a drive letter to an alternate let- : console command that disables
ter. | disable Recovery or drivers
. H Windows system services '
-assoc  View the file associations. Compare a disk with another disk.
at Schedule a time to execute commands or | diskcomp P £ disk and pla;
prograrns. diskcopy Copy the contents Okone Place
atmadm Lists connections and addresses seen by them on another disk.
Windows ATM call manager. edit View and edit files.
attrib Display and change file attributes. edlin View and edit files.
batch Recovery console command that executes erase Erase files from computer.
a series of commands in a file. th and interpreter
bootcfg  Recovery console command that allows a exit Exit from the c? P )
user to view, modify, and rebuild the fasthelp Displays a listing of MS-DOS commands
boot.ini and information about them.
break Enable / disable CTRL + C feature. fdisk Utility used to create partitions on the
cacls View and modify file ACL's. hard disk drive. -
call Calls a batch file from another batch file. find Search for text within a file.
od Changes directories. ' findstr  Searches for a string of text within a file.
chep Supplement the International keyboard | fixboot Writes a new boot sector. ’
and character set information. br  Writes a new boot
chdir Changes directories. ff:ﬂrmnat . W Doot record to a disk drive.
chdsk  Check the hard disk drive running FAT deenand to erase and prepare a disk
for errors. - o .o ‘
chintfs  Check the hard disk drive running NTFS- | "°F  Display a listing of commands and brief
for errors, explanation,
choice  Specify a listing of multiple options i Allows for batch files to perform conidi-
within a batch file. tional processing,
cls Clears the screen, ishlp.sys 32-bit file manager.
m:d '~ Opens the command interpreter, ;xe_vb Change layout of keyboard.
color Easily change the foreground and back- abel Change the lahe]
ground color of the MS-DOS window. 1h | g abel of a disk drive.
W, Load a device driver in
command Opens the command Interpreter. listsve Reg I to high memory.
over
compact  Compresses and uncompress fles, the se:gc:?;?;edcommand that displays
control  Open Contro! Panel icons from the Ms- | lock Lock rivers.
DOS prompt. logoft Ck the hard disk drive,
logo
convert  Convert FAT to NTFS. 8 ]I;E%:f the currently profile using the com-
Copy .
E:t;g l;me or'more files to an alternate 1. logon Recoy
date ' : lati €Iy console command to list instal-
debr View or change the systems date, ma; one &nd enable administrator logint.
L bug ]t:’oc?nuogd::'ymlllty 1o create assembly programs | mdp Displays the device name of a drive.
ardware settings, e Command to create g tiew directory.

== Kiran's Computer
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Display memory on system.
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S b L Command to cr ‘ ' '

mkﬂifi 3 Moo o o cate a new directory. rmdir Removes an empty directory.

pove to anotl'ner-m?ec:;ﬁrt:,les from one directory route View and configure windows network
! : route tables.
; Utility used to 1 ‘ .
. padex the CD-ROM. oad and provide access to scandisk Run the scandisk utility.
| ) : scanreg Scan d ‘ 1 er-
[ pet Update, fix, or view the network or net- ¢ 1015, reglstry and recover reglstry from er

work settings
] « shutdown Shutdown the computer from the MS-
ookup Look up an IP address of 3 ¢

e on a network. omain or host DOS prompt.

l thping View and locate locations of network la. sys Transfer system files to disk drive.
tency. time View or modify the system time.
print Prints data to a printer port. tree View a visual tree of the har_d disk drive.
| prompt View and change the MS-DOS prompt. type Display the contents of a file.
- d Removes an empty directory. undelete Undelete a file that has been deleted.
| gname Renames a file or dire ctory. unformat Unformat a hard disk drive.

ARRANGEMENT IN MS-DOS

BYTES \
(Collection of —_—
Characters)

FILE
(Collection of <5,  (Collection
Bytes) of Files)

DIRECTORY

letus understand, what the above diagram telling us. It states that a collecting of characters (c.g..a, b, c,

31 *) make a “BYTE". And further this collection of Bytes make a “FILE" (e.g.. data stored — Hello world" or

- any graphic). And this collection of file stored into a directory.

| For example, as we see in any of industries or in any organisation number of file should contain in a
folder for the security and convenience. The same principle is used by the DOS. :

So, the next thing we should care that these files sometimes need some modification (changes), some of
the files be useless after some time and some will be checked from time to time.

So, in order to perform above task DOS faciliate us with seme of its useful commands and they are categorised
| @ stated below :

DOS

Availability of Command
Divided into

File Management Batch File
Commands Commands
) ) ————— | System
: Disk Management - { Configuration
Commands v Commands

General |
| Commands |

1t s and It’nnwlPr’TFC
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MICROSOFT WINDOWS XP ettmes
Windows XP : An operating Slt’hs;ecrgﬁ;z ter USES
called an “0S", is the main program tasall
to function properly. Operating systems ac 4 use on
between you, the user, and the programs yo differ-
a computer. Different types of computers use £ com
ent types of operating systems. The ma.im'“l‘ft‘l’:l o
puters used either run Microsoft Windows or the Mac
OS. While fAles can be shared between these two types
of systems, they are generally incompatible.

Windows Features : Most PCs run on an operat-
ing system called Windows, These particular tutorial
deals with the Windows XP professional version of the
Windows operating system. The operating system is
what allows you as the user to access the informa-
tion In the computer. To understand how to use a
computer, it is important to know several features of
the Windows system.

Desktop : The desktop is the area you see when
the computer 18 not running applications. It consists
of the icons on top of it, as well as the Start button
and other features, The desktop can be used to tem-
porarily store information or to move around docu-
ments and windows,

| certain commands, such as to save yo

o ER Vew oot Fomst Tods Tge
E nadil
JH P TmosfewRoman « 12 « | B I U 4@‘5_

Jcon : Icons are little pictures that represent dif.
ferent programs or saved items. Double-clicking on the
icon accesses the information icons represent,

window : Each application opened will appear i,
its own window, or its own little section of the sereey,
Windows can be moved and resized so that you cap
operate many different applications at the same time,
To learn how to mantpulate windows, refer to the Ma.
nipulating Windows portion of Level.

Dialogue Box : When you ask the computer to dq
' ; ur work, the com-

more information from you, and thig

dialogue box. These boxes contain
r the computer to execute,

puter will need
will appear in a
options and commands fo

Start Menu : The Start Menu provided a
customizable nested list of programs for the user to
launch, as well as a list of most recently opened docu-
ments, a way to find files and get help, and access to
the system settings, Later enhancements via Windows
Desktop Update included access to special folders like
"My Documents,” "Favourites" etc, Windows XP's Start
Menu was expanded to encompass various My Docu-
ments folders {including My Music and My Pictures),
and transplanted other items like My Computer and
My Network Places from the Windows desktop.

window

-.‘ua

Assistancg " TTTITER

! ”3’5 Takle ﬁ}:pr.ie_nt:

D ke
i OmceOnline

start menu

] N = -
@ Titeries Evplores .7 My Documents ’ * ’ g:rﬂ]r?"r e Maredaft Offics
. . e
. LI & Q
(9.} E=malt -« My Recent Dorunients  » | 1 B T Getthelatest 5 abott Lesing
? rartgaorr SFfice el 5 TaHE B ‘.'5 @<, ¥ ": Weed -
' O My pictures o > EITEGDLOE e
— o e Ln 1 T
#Adobo PapeMaler 6,5 i ’ My Music = = , ' -
: .. El = = o
;'“ c o g! My Computer
J g 1y Network Places
w =)
o [~ conrctpanst
2.7 Windowss Media Mlayer Set Progr
. ! . am
@a 554 Program Acvess and
b coskunise g Privtees and Faxes
..% Windows Messenger ) help and support
i
L3 H p Seacch
All Pragrams 9 B 7 Run

task bar
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" - Tashkbar : The taskbar is the long horizontal bar
‘gt the bottom of your screen, Unlike the desktop,
which can get obscured by the windows on top of it,
the taskbar is visible almost all the time. It has four
main sections:

6 The Start button, which opens the Start menu.

© The Quick Launch toolbar, which lets you start
programs with one click.

@ The middle section, which shows you which pro-
grams and documents you have open and al-
lows you to quickly switch between them.

© The notification area, which includes a clock
and icons (small pictures) that communicate

the status of certain programs and computer
settings,

Title Bar : Title Bar located along the top of a
window or a dialog box that displays the name of the
window or software program being used.

Toolbar : A toolbar is a set of icons or buttons
that are part of a software program's interface or an
open window. When it is part of a program's inter-
face, the toolbar typically sits directly under the menu
bar. For example, Adobe Photoshop includes a toolbar
that allows you to adjust settings for each selected
tool. If the paintbrush is selected, the toolbar will pro-
vide options to change the brush size, opacity, and
flow. Microsoft Word has a toolbar with icons that al-
low you to open, save, and print documents, as well
as change the font, text size, and style of the text.
Like many programs, the Word toolbar can be custom-
ized by adding or deleting options. It can even be
moved to different parts of the screen.

Menu Bar : A menu bar is a horizontal strip that
contains lists of available menus for a certain pro-
gram, In Windows programs, the menu bar resides at
the top of each open window, while on the Mac, the

menu bar is always fixed on the top of the screen. De- | E:

spite this major difference, the menu bar serves the
same purpose on each platform. :

Example of Microsoft Windows window
Maxmize f Resize ~nqn

" Menu bar Titebar Minimize —o 3] X
a:m-go;g ™y ) =10 =i
Ler Y  gew G liookmats ol e .
vas g e | =] . teath v w +3— Toolbar
Crrgarrie. | Tomw Ed tomputer Ha ; =
’ A vertica

-

Moo Canteet Froe Melp [T
Nragafy -]
2. o) i)
,-.‘.\"__ o \ 4.
/, ~ Fd
Ma bar Morsizantal scroll bar Resicg carner
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Nearly all programs have a menu bar as part of
their user interface. It includes menu items and op-
tions specific to the particular program. Most menu
bars have the the standard File, Edit, and View menus
listed first. The File menu includes options such as
Save and Open File..., the Edit menu has items such
as Undo, Copy, Paste, and Select All, while in the View
menu you'll find viewing options such as changing the
layeut of open windows. Word processing programs,
such as Microsoft Word, also include menu options
such as Insert, Format, and Font which you will most
likely not find in a Web browser's menu bar.

Status Bar : A status bar is a small area at the
bottom of a window. It is used by some applications
to display helpful information for the user. For ex-
ample, an open folder window on the desktop may dis-
play the number of items in the folder and how many
items are selected

Scroll Bar : When the contents of a window are
too large to be displayed entirely within the window,
a scroll bar will appear, For example, il a Web page is
too long to fit within a window, a scroll bar will show
up on the right-hand side of the window, allowing you
to scroll up and down the page. If the page is too wide
for the window, another scroll bar will appear at the
bottom of the window, allowing you to scroll to the
left and right. If the window's contents fit within the
current window size, the seroll bars will not appear.

Tab Menu : Tab menus, which are often present
in dialogue boxes, are menus that represent many dif-
ferent “pages” of information. To access each 'page,”
click on the tab at the top of the dialogue box.

Tabs

. . . 4
S NP TSV ST S S

STARTUP, SHUT DOWN AND SLEEP )
Start up : First of all, you will need to turn the

computer on. Do this by pushing the power button *

on the front of the computer unit. The computer takes
a few minutes to start up, so be patient.
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Shut Down : To shut down, click with {3:::: ';‘l?‘t‘he
on the button in the lower left-hand Cg ap, click
screen labeled Start. On the menu thatp P: dialogue
on Turn off computer. This will El'cﬁ?g up off" It is
box with more options In it. Cli:.;1 . olffmthne computer

tant{ to remember that turn ‘ .
;Jl;q:;:'gssing the power button without going throug

] ter.
the shut down process may damage the compu

TGRS

> -’.{“_ S » :mj
3 " T U L e )
Stand By : When a computer is left alone for a
while, it goes into "sleep” or “stand by" mode to save
energy. In stand by mode, the computer slows down
its inner processes because they are not being used.
The computer also blacks out the monitor. If you wish
to use a computer and the monitor is dark, check to
see if it is in stand by before you try to start it up.
Usually, the computer has a green light on or near
the power button that signifies that it is on, but in
stand by mode. To "wake it up,” move the mouse or
hit a key on the keyboard. In about 8-10 seconds the
computer will wake up and be fully functional. If you
do not realize that the computer is in stand by and
you try to turn it on with the power button, the com-
puter will wake up and a dialogue hox will appear, but
1t wiil not damage the computer.

Hibemation : Hibernation is a feature of many
computer operating systems where the contents of
RAM are written to non-volatile storage such as a hard
disk, as a file or on a separate partition, before pow-
ering off the computer. When the computer is restarted
it reloads the content of memory and is restored to
the state it was in when hibernation was invoked, Hj-
bernation is used as an alternative to Powering down
the computer, because hibernating and later restart-
Ing is usually faster thap closing down, later starting
up, and starting all the Programs that
Going into hibernation requires no us
shutting down when programs are open either requires
mif éti;?mti::n?)l::ed Properly, or user interaction to

» With possible Jogsg of data -
ditional work on the part of the user to save a?lr 31('11—
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""" GPENING AND CLOSING AN APPPLICATION

To open an application you have £wo options; )
1. Open the Start mentu and click on the nam, -

of the application. . ;
the icon for the application and eithe;
o right click and choose Open,

2. Find
double click it or

Scan for Yiruses

CDExtract k0. _
Extract to folder C :\Doc... AStu...\Des. .. {QuickvD
r

=1 (510pen with WinZip

Send To

Cut
Copy

Create Shorteut
Delete
Rename

Propertles

Ta close an application:

1. Most applications can be closed by choosing L
“File” menu and selecting Quit or Exit.

2, If no file menu is available, click the “X" but-

ton in the upper right-hand corner of the
application's window.

New Cri+l
Open.., o
Save Cri+s
Save As,,, :'
Page Setup, . o
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MANIPULATING WINDOWS

The sizes of the windows on your screen can be
changed so that more windows are visible. Following
is & list of common features that can be implemented
on all windows.

Maximize : This function allows you to concen-
trate on one application by making its window cover
the entire screen., :

Minimize : This function allows you to keep an
application running, but remove it from the desktop
area so that other applications can be accessed. The
minimized program becomes a bar at the bottom of
the screen, and can be accessed by clicking on the bar.

Resize : If an application window is not maxi-
mized, it can be resized so that more or less content
can be seen. If you move your mouse pointer to one
of the edges of the window, it will become a two-way
arrow. At this point, hold down the left mouse but-
ton and drag the. perimeter of the window in or out.
When you release the mouse button, the window will
resize to your specifications.

! @8- Windows ‘
1 B2 PENLERE
i B9 Disk1_vol3 (E:
= &y My Disc () :
@-{ ] Delhi Police-51-0:
B W) -
(] Printers |
.{£g) DialUp Networking -,
..{&] Scheduled Tasks .
1| B1-€8 WebFolders

| B1-£%} My Documents
El Internet Exploser i
‘ E'g Network Neighbathood ™

Resize Eé,} Recycle Bin .

I
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Close : This function closes and exits the appli-
cation you are running. However, if you are running
an application such as Microsoft Word, the window
of each document will have a close button, and click-
Ing this button will only close that particular docu-

| ment, and not the entire program. It is important to

always save your work before using the close feature,
as any unsaved changes will be lost.
SAVING

Saving material onto a disk stores that material
so that it can be accessed again. Any work you do on
the computer should be saved, including papers and
other assignments. Although you may be working in
different applications, the saving procedure is gener-
ally the same.

1. Insert a disk into the correct disk drive.

2. Go under the File menu in the application,
and choose “Save As.”

3. When the Save As dialogue box appears, click
the arrow button next to the Save In box. This
will cause a menu of save options to appear.

4. To save on your removable disk, choose either
the 3 1/2" Floppy Drive or the Zip Drive ac-
cordingly.

" . save options
save in” box P

IEETREAY)
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document name save button

5. Type in a filename that will identify your docu-
ment at the bottom of the box.

6. Click the Save button located in the lower
right-hand corner of the box.

7. Save work as you continue, you only need to
click on the save icon or go under File > Save.

TIPS FOR SAVING

@ Save often. This Is by far the most important
step in the saving procedure. The more you save,
the less chance you have of losing any of vour
hard work, Errors and {reeze-ups can occur,
and unsaved work will be lost, Also, always save
before printing because this is the time when
niany ¢rrors Qocur,

o Use specific filenames, When niuning your sm'gr(i
works, label them with detailed names so oo

N T MR
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of errors. Make

f one
on two disks so that 1
a backup copy on another disk.

PRINTING o
Most applications print in a similar on.

w these steps to print your work.
an:. Save yo:fs work. Computers gometimes
freeze when you ask them to print, and all
of your work may be lost.

2. Go under the File menu to Print.

3. When the dialogue box appears. check to make
sure that the printer listed is the printer in the
lab you are in. If it is not, click on the arrow
to the right of the printer name and choose the

important works
sure you sav.'cflsl u fsils you have

correct printer.

Printer name

4. Choose how many copies you would Iy,
printed.

5. Decide if you on
to be printed and choose
to print.

8. Click OK.

Printing from Your Dorm Room it is possible ¢,
print documents from a PC in your dorim room to the
printer in the lab of your building. If you are intey.
ested in having this option, call to schgdule an ap.
pointment with the Residential Computing Connec.
tion (RCC) at 372-0525 or visit their website by click.
ing the link on the left side of the top of your screep

called “Residential Computing.”

the number of page,

number of copies

Printer: [ e R R AR -] [} Print
- = ' 3 i
PPD: Color Eeney ﬂ I” Callate Cancel |
- —— [ Reverse R
Copies: |1 7 ™ Proof .
 Pages - 1 Dociment
& All Print: |Both Péges j Paper
" Banges: 1 I” Reader's spreads Options
I” Ignore “Non-ﬁf/tinting“ setting I” Print blank pages —
3 ~ Book / ] o
| ok _ Orientation T
‘ r' Print all plblications in hook & [N Features
™ Use parler sethings of each publication !
i 7L ‘ L Reset
5 page range
-;. “OK" to print

DELETING FILES

If you choose to delete an item fr

: om you
from the computer's hard drive, you wiﬂyne;ddii:ikazf

‘hard drive, usé the following steps,

Hitison a Tremovable disk,

disk into the correct drive. first insert the

Next double-click

on the - i .
Choose thi dc;? Puter icon on the Desktop-

that th

by double click € e item is located on
Ing the appropriat e foon.

Open the file that the itempisliogafedd?r:? -

2. Left-click on th
and hold the buettg:gn;ou\;:gt you wish to delete

3. Dra
g the ftem out of the window it is in awd

Place it over th
Desktop. ¢ Recycle Bin loeated on the

- Kiran's Computer Literacy and Knowledee
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4. When the Recycle Bin is highlighted, release |
the button. The item should disappear from the |
drive.

8. When the dialogue box appears asking you if
léou are sure you want to delete this item, click

20.

item to
be
deleted

ifems in the Recycle Bin, they

When you deposit
will not be permanently removed from the computers

do so. If you decide

Memory without you telling it to
double-click on the

you still want to keep something,

Recycle Bin and drag the item back out. To perma- |

nently erase an item from the computer, right-click
on the Recycle Bin and choose Empty Recycle Bin.
Remember, once you empty the Recycle Bin, the items

Cieate Shottout

E P;operuea %
Y 5. o Mo 3 A 325 0 A BN 1L

Backup : A backup is a copy of one or more files
created as an alternate in case the original data is lost
or becomes unusable. For example, you may save Sev-
eral coples of a research paper on your hard drive as
backup files in case you decide to use a previous revi-
sion. Better yet, you could save the backups to a USB

hard drive failed.
Help Option : Located in the Start menu is the
Windows Help and Support option. If you have any
problems with the Windows systems or have questions
about how to do something, the Help option may have
the answer. If the computer does have the Help op-
tion, follow these steps to use it.

1. Select Help and Support from the Start menu.

: g_;f] barp COOnBUASe
’ ﬁj by hiebaoal: Plares

: E, o Pored

: {i} Lo Frie)icn Slis A
L D‘lﬁ-’l’.kl:

-
{nh Froders anal Fav

2, Choose to view Help and Support by one of
the following categories: Index, Support, His-
tory, Favorites, or Options. Select the category
that you would like by clicking the appropriate
button.

3. Click on the heading of your choice in the list
located on the left side of the screen, or if you
are in the Index category, click on Locate in

Inside will be permanently erased from the computer's |

‘__ﬂ'lemory,
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Contents to type in a keyword.

L SENREE R IED

flash disk, which would also protect the files if the
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COMMON DOS ANDDON'TS

Computers are powerful machines that can aid us

in many of our everyday tasks. Computers are, how-
ever, rather fragile and should be treated in a respect-
ful manner. Following is a list of dos and don'ts that
will preserve the life of the computer while letting you
get the most out of the machine.

DO:

© Save ydur work often. This prevents the loss of

“hours of work.

@ Back up your work In case

ask an

~ account
person
a question

choose a
specific file
task you
need help
with

© Strike the computer or physically abuse it.

@ Print more than one copy of your work in the
compufer labs. The printers are for printing
work, and not to do the job of a copy machine.

© Change the settings of on-campus computers.
If you are having problems, please ask the lab
staff for help.

THE START MENU

In the bottom left-hand corner of the Windows
screen is a button labeled “Start.” This button dis-

of disk malfunction.

© Ask lab staff for help at any
time.

@ Shut down the computer
when you are finished. This

Start
Menu

; &dobe PageMaker .

™ Nero 7 Demo
! T Quick Heal Antivirus Plys
f@ QuickTime for Windows

means do not press the

power button, but go
through the shut down pro-
cedure under the Start
menu.
DON'T:

© Eat or drink around a com-
puter. Spilled drinks and
food can harm a computer’s
hardware. Food and drinks
are not allowed in on-cam-
pus labs, but if for some rea-
son you do spill something
on a computer, report it to

the staff on duty immeds-
ately,

Start
Bution
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@ Startup

@ winzip

L B Adobe ImageReady 7,9
K3 Adobs Photoshop 7.0
‘ i Adobe Reader g

il & Internet Explorer

A %8 Msy

i” ) Qutlook Express

1 Remote Assistance
Windows Media Player
B Windows Messengar
S B Windows Movie Maker

Programs
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* plays @ menu that gives you access to many of the
:  computer's features. Once the Start menu is opened,

you have to do is highlight what you want and
more options will appear. Here we will discuss the
many features and uses of the Start menu from top
to bottom.

New Office Document : This feature acts as a
shorteut for opening a new document in Microsoft Of-
fice. You can choose from a varlety of document for-
mats.

Open Office Document : This feature acts as a |

shortcut for accessing a saved document or file.

Windows Catalog : This item opens Internet Ex- |

plorer to a site in which you can purchase products
butlt for Windows systems. '

Windows Update : This item opens Internet Ex-

plorer to a site in which you can download updates |

for your Windows operating system.

Programs : This prompt will open another menu
filled with more options. These options are all pro-
grams that the computer can run. To see what the
Programs menu has to offer, refer to the Programs
page.

Documents ; This item allows you to temporarily
store saved works.

Settings : This menu contains access to the Con-
trol Panel as well as your Network Connections; Print-
ers and Faxes; and Taskbar and Start Menu. Through
these options you can'customize the appearance and
functions of your computer.

Search : This menu allows you to find anything
on the computer or on the Intemnet.

Help and Support : This feature will open the
Windows Help and Support Menu. To use this feature,
refer to the Help Option section of Level 1.

Rum : This itemn allows you to run programs lo-
cated on a disk, CD, or on the Internet.

Log Off : This allows you to log off the computer,
{It 15 not important for use in your own home or in a
cormnputer lab).

Turn Off Computer : When this phrase is
clicked, the Shut Down menu will appear, allowing
you to hibernate, shut down, or restart the computer.
To use this feature, refer to the Start Up and Shut

Down portion of Level 1.

COMPUTER FREEZES

There are often times when you are working on a
computer and it “freezes"-that is the mouse and key-
board no longer affect the computer. No matter what
¥you click on, nothing happens. Sometimes the mouse
Cursor won't even move on the screeri. This may hap-
Pen for a number of reasons including memory fill-
up-or glitches in the system. This problem, however,
tan often be fixed. If your screen freezes (this is some-
Himes referred to as crashing) and nothing seems to
be happening, use these steps to unfréeze it It is im-

' oy,
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poriant to remember, however, that these steps will
not always fix the situation, and sometimes the only
thing left to do is turn the computer off by pushing
the power bution.

1. Press Ctrl+Alt+Del. This will cause the com-
puter to show a dialogue box that lists the cur-
rent applications that are running on the com-
puter. Most likely, the application you are us-
ing will be listed here at the top, often with the
phrase “not responding” behind it. This means
that the particular application you are running
has frozen and you need to shut this applica-
tion down.

2. Click on the application causing the problem,
and then click the End Task button.

3. Another dialogue box will appear and ask you
to confirm your decision. Click End Task again.
Under normal circumstances this process will
shut down the problematic application and the
computer will be restored to its previous run-
ning state. It will also give you the option to
shut the computer down if you choose to do
50.

4. Sometimes, however, clicking on a particular
task and trying to end it will not always do the
trick. The only option left is to press
Ctrl+Alt+Del again, which will cause the com-
puter to restart. Any unsaved work will be lost -
in this instance, so make sure you save often
to avoid redoing work.

There are a number of things you can do to pre-

vent and avoid freezes and crashes.

Only open the applications you will be using-ex-
tra applications take up more memory and can cause
freeze-ups. When you sit down at the computer, check
to see that no applications were left running by the
previous user. These running applications will often
be minimized at the bottom of the screen. If you are
using an application that requires a lot of memory,
such as PowerPoint or PhotoShop, do not attempt to
open other programs, as a freeze-up may occur when
memory fills up.

INTERNET ACCESS

To access the Internet from a computer, you need
to open a web browser. A web browser is a program
such as Netscape Communicator or Internet Explorer
that allows you to surf the net. Computers riormally
have both web browsers, and you may use either on
a PC. Web browsers function similar to most other ap-
plications, so they are opened and closed in the same
general manner as regular applications. If you are in-
terested in acquiring the latest version of Netscape or
Internet Explorer, download them free of charge at
Download.com, or check out the CD Rom at the Li-
brary Circulation Desk. There are basically three ways
to acceas the Internet from a PC.
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: ' CTRL + F3
' desk- Find
1. Double-click the web browser icon on the des Help ;}li ) .
o d Minimize Window ndows Key* + M
‘ —3> Programs —>Internet, an |
% gie(:'lkti::lkt :::&1; w:b browser of your choice. Move to Recycling CTRL + DEL
3. Click the web browser shortcut on the task bar New Folder/Document CTRL + g
"located at the bottom of the screen. Open C’I‘RL‘+
Open Start Menu Windows Key'
Paste CTRL +V
Page Up/Down Page Up/Down Keys
Print CTRL + P
Print Screen ALT + Print Screen Key
Quit ALT + F4
Reboot/Reatart CTRL + ALT + DEL
Save CTRL + 8
Select All CTRL + A
COMMON APPLICATIONS Undo CTRL + Z

Each computer is preloaded with various appli-
cations that you may use during your stay. Although
each computer contains different software, most of
them contain the same basic applications that you
will use frequently. We list some of the most widely
used applications here.

Microsoft Word : Use to type a paper. Microsoft
Word 1s a word processing application that allows you
to format your text as well as add graphics, tables and

. charts. Found in Start menu > Programs > Microsoft

Word.

Netscape or Internet Explorer Use to access the
Internet. Found in Start menu > Programs > Internet
Explorer {or Netscape Communicator.

Windows Media Player : Use to listen to a CD.
This program allows you to listen to your favorite CDs
while you work. It includes programming features and
volume controls. Found in Start menu > Programs >
Accessories > Entertainment -> Windows Media Player.

Calculator : Use to do math on the computer. The
Windows Calculator can be used by pointing and
clicking the calculator on the screen, or by typing in
the numbers on the keyboard. Found in Start Menu
> Programs > Accessories > Calculator.

WINDOWS KEYBOARD SHORTCUTS
Keyboard shortcuts are key commands that allow
Yyou to accomplish various tasks, Instead of using your
mouse to go through menus and sub-menus, you can
use keyboard shorteuts to do common tasks like sav-

ing, copying, or pasting. Most people find using key |

shortcuts to be a faster and easier way to type. Listed
i

- below are some of ical order,
. The most common keyboard shortcuts in alpha- |

betical order,
Close CTRL + W
Copy - CTRL + ¢
Cut CTRL + X
" Delete DEL Exit ESC

ST
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* Not all keyboards have the Windows key. CTR,
is the abbreviation for the Control key. DEL is the
abbreviation for the Delete key.

THE RIGHT CLICK MENU

When you right-click your mouse, a small menu
will appear. This is the right-click menu, and it con-
tains a Hst of the common tasks for whatever program
you're currently using. If you use the right-click menu
you can leave your cursor in roughly the same spot,
which makes resuming your task easier. Each
program’s right-click menu will be unique and look
slightly different from others, but most follow the same
general format. As an example, the following picture
Is what a menu would look like if you right-clicked
on the desktop.

TR L CDEEEREINY, 20 ogsey s,
Arrange Icons By b ]
Refresh

Faske Shaorbogh

Undo Copy Ctri+-Z

T e e

Graphics Properties, .,
Graphics Options

M T

Properties
R 3 et s .

Arrows along the right side of the menu signél

| that there is a sub-menu for that particular item

These sub-menus contain even more shortcuts that
are grouped together in a category.

To exit the right-click menu, left-click on any part
of the screen bestdes the menu.




 the Internet. There is another kind of explorer
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WINDOWS EXPLORER '

[ you are familiar with Internet Explorer, you know that it helps you find web pages and information on

7 ‘ on your computer: Windows Explorer. The basic idea”behind
windows Explorer is very similar to Internet Explorer. The program lets you look through all of the files and

folders on your computer, You can €ven open, copy, cut, and Paste your files from inside Windows Explorer.

The frame on the left shows the contents of your entire computer. To see what's inside of a particular

directory, click on the plus (+) sign. To hide what's inside of a directory, click the minus (-) sign that replaced
the plus sign. ~

Thevframe on the right side shows you only the contents of the folder or directory that you've selected.
Sometimes you must go through several directories and folders to get to the file you want.

|ﬁ? ! J::} Search L{::‘ Folders r v

3 '??f:lcn:)rel User Files
& i !lf:i:ﬂ My Musie
My Pictures
ig_‘j NeroVislon

I Updaters

‘
T

« T3 Make a new folder
v @ Publish this Folder to the
Weh

Py e

k=2 Share this folder

L A AR I L O a7

i Other Places

=hrbe,

(ORI Rk iy R O AR St sl
AN DR .

i F P T P e YO

OBJIJECTIVE QUES  TIONS

1. The PC (personal computer) and by which users can interact (1) Duping 27 Booting
the Apple Macintosh.are ex- with the computer. (3) Padding (4) All of above
Aaqr)ggles of two different: (1) The platform ) ‘ (5} None of these
tf 2) applications. he operating systerir- . 6. A name or number used to
@) pla 0@: (2) app ‘ (3) Application software identify a storage location de-
programs. ’ (4) The motherboard vices?
(4] storage devices. (5] None of these (1) A byte
(5) None of these | 4. File extensions are used in or- (2} A record
2. Apple Macintoshes (Macs) and der to. An address
PCs use different _____ (1) Name the file s ot {4} All of above
to-process data and different (2) Ensure the filename is no (5) None of these .
operating systems. lost il 7. Which is of the following is
(1) languages (2) methods 4[2; ;g:ggg‘g‘: ﬁl: type NOT a famous operating sys-
CPUs tem?
(5) None of these | ‘
i :g} i}toragefd;vices B. The processes of starting or re- g; g:;doogi(v:“i —
one of these . starting a computer system by : 1 Box
3, ——. controls the way loading instructions from a (4) Sun OS Virtual Box
in which the computer system ge device into ~_ Bank of Bareda Clérk
o secondary storage - 80.11.3008
+ . functfons and provides a means the computer memory is called . Exam, SO.11.

3,
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-+ (1) title bar

8. What happens when you boot

upaPC?

‘&L&Ylsortions of the operating
system are copied from disk
into memory

(2) Portions of the operating
system are copied from
memory onto disk

(3) Portions of the operating
system are compiled

(4) Portions of the operating
system are emulated

{5) None of these

SBI PO Tier-2 Exam, 13.10.2008

9. The operating system is the

most common type of

software.

(1) communication

(2} applicationﬁiﬁ:stems

{4) word - processing

{5) None of these

Allahabad Bank Clerk

Exam, 31.08.2008

10. In DOS, which of the follow-

ing command is used to delete

all the files as well as sub-di-
rectories of a directory?

(1) Delete (2) Del

J3Deltree  (4) Move

(5) None of these

11. is when the computer is
turned on and the operating
system is loading.
Booting  (2) Flashing
(3) Tracking  (4) Taping
(5) None of these
12. The allows you to access
object and start programme.

(1) Default menu

(2) XPmeénu (3}

menu
{4) Stop menu
(5) None of these
13. controls the way in

which the computer system
functions and provides a
means by which users can in-
teract with the compujsr.

(1) The platform
) € operating system
) Application software

{4) The motherhoard
{5) None of these
SBI PO TierI Exam, 27.07.2008
14. The of software con-
tains lists of commands and

options, ‘
%ﬂenu bar

(3) formula bar (4) tool bar

None of these
®) SBI Clerk Exam, Second

sitting, 13.07.2008
15. What menu is selected to cut,
copy, and paste ?
(1) File (2) Tools
(8) Special fdit
{5) None of these
16. The ability to find an individu-
al item in a fille immediately
— isused.
(1) file allocation table
(2) directory
(3) sequential access
{4)direct access
{5) None of these
SBI Clerk Exam, 06.07.2008
17. To move to the beginning of a

line of text, press the key.
ome 2)a
(3) page up (4) enter

(5) None of these
18. The tells the computer
how to use its components.
(1) utility (2) network
‘,[.‘}i"c;p erating system
(4) application program
(5) None of these
19. A collection of programs that
controls how your computer
system runs and processes in-
formation is called
A1) operating system
(2) computer (3} office
(4) compiler (5) interpreter
20. Which of the following can
" handle most system functions
that aren't handled directly by
the operating system?
(1) Vertical market applica-
tions
_AZ] Utilities (3) Algorithms
{4) Integrated software
(5) Compilers
SBI Clerk Exam, 06.07.2008
21. Dos and windows 3.x support
file names upto _____ charac-
ters in length.
(1) Two (2) Four
(3) Six Eight
(5) None of these ~_
22. In Dos, the “Label” command
is used to
(1) create the label of disk
(2) change the label of disk
(3) remove the label of disk

Operating ngt'e!m

(4) Both (1) and (2)
1 of the above

_ SBI Clerk Exam, 25.11,20075_
23. Which command is used
delete file from a directory y :

DOS.

(JREN  (2rDEL
(3)CD (4) MD
(5) None of these

SBI Clerk Exam, 25.11.200,

24. Which process checks to gy, |

sure the components of the

computer are operating ang .

connected properly ?

_i1) Booting (2) Processing
(3) Saving  (4) Editing
(5) None of these

SBI Clerk Exam, 19.08,2007

25, What is backup ?

(1) Adding more components

to your network
_[2}-Protecting data by copying
_it from the original source
to a different destination
(3) Filtering old data from the
new data
(4) Accessing data on tape
{5) None of these

SBI PO TierI Exam, 13.10.2008

26. What is the main folder on a
storage device called ?
(1) Platform (2) Interface
A3FRoot directory
(4) device driver
(5) None of these
SBI PO Tier-I Exam, 13.10.2008
27. The device that assembles
groups of characters into com-
plete messages prior to their
entering the CPU is called
(1) An Interpreter
(2) A Compiler
Communication proces-
sor
(4) An Editor T
(5) A Translator

SBI Clerk Exam, 10.02.2008

28. The subsystem of the kernel

and hardware that cooperates

to translate virtual to physt :

cal addresses comprises .
(1) Process Management Sub*
system
emory Management Sub-
system

(3) Input/Qutput Manage

ment Subsystem
(4) All of the above
{8} None of these

SBI Clerk Exam. 285,11.5007
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{1]‘N§me given

{2) Document given
JS?File name

(4) Document identify
(5) None of these .

32. Howmany different documents
can you have opened at any
one time?

{1) No more than three
(2) Only one
}M many as you computer
memory will hold
{4) No more than your taskbar
can display
(5) None of these

33. Editing document consist of
testing through the document
you've created them.

rrecting you €rrors
{2) Printing it
(3) Saving it (4) Deleting it
(5) None of these

34. Hackers

(1) All have the same motive
Break into other people’s |

computers ,

(3) May legally break into com-

puters as long as they do not

do any damage

(4) Are people who are allergic

to computers’ :

{5) none of these

88. One or more defects or prob-
lems that prevent the goftware
from working as intended or |

: rking at all is a(n).
% Bug
{2) Boot

(3) Programming language
. (4) Fuzzy loglc
(5) None of these

Kiran'

: ”Agi{) : ™ is a program that | ;
; “makes the computer easi — ; | '
e aster to | — ANSWERS ==
(1) Operating system 7 1 - - ‘
\ D 203 3.2 4@
(2) Application - 4]
_@putility  (4) Networls 5.2 | 83| 7.6 | 80
(5) None of these 9.3 | 10.(3) | 11.(1) | 12.(3)
SBI Clerk Exam, Second | |—2-(2) | 14.(2) | 15.(4) | 16.(4)
Sitting, 13.07.2007 | | 17. (1) | 18.(3) [ 19.(1) | 20.(2)
90. gf:m{’gme files by storing | [ 21.14) | 22.(59 | 23. @@ [ 24.(1)
(1) Archives 2] Folders 25.(2) | 26.{3) | 27.(3) | 28.(2)
(3} Indexes  (4) Lists 29, (3) | 30.(2) | 31.(3) § 32.(3)
(5) None of these 83. (1) | 34.(2) | 35.(1) |
3l. The name that the user gives ' , '
toadocument is referred toas. | = EXPLANATIONS ==

11. (1) PC stands for Personal Com-
puter and refers to any IBM-
compatible computer. The term
PC comes from the first personal
computer made by IBM. A com-
puter that is IBM-compatible
means that its architecture is
based on the IBM microproces-
sor. A number of different op-
erating systems are compatible

with PCs, the most popular of |

which is Microsoft Windows.
Somie others are the UNIX vari-
ants, such as Linux, FreeBSD
and Solaris.

Mac is short for Macintosh and
refers to any computer produced
by Apple Computer. Macs are
traditionally classified sepa-
rately from PCs because they are
based on the PowerPC architec-
ture from Apple/IBM/Motorola
instead of the traditional Intel
based microprocessors that
have powered PCs for decades.

5. (2) Process that start up the
computer called booting, After
we switch ON the power it
checks the proper functioning
of all the peripheral devices at-
tached with computer. Load the
Operating system in main
memory.

9. (3) System software is computer
software designed to operate
the computer hardware and to
provide & platform for
running application software.
System software is composed of
operating system and system

utitities.

s Computer Literacy and Knowledge

12. (3)The Start menu is the main
gateway to your computer's pro-
grams, folders, and settings. It's
called a menu because it pro-
vides a list of choices, just as a
restauranl menu does. And as
“Start” implies, it's often the
place that you'll go to start or
open things. To open the Start
meniy, click the Start button in
the lower-lef! vorner of your
screen. Or, press the Windows
logo key on your keyhoard. The
Start menu appears.
{2) A menu bar is a horizontal
strip that contains lists of avail-
able menus for a certain pro-
gram. In Windows programs,
the menu bar resides at the top
of each open window. Most
menu bars have the standard
File, Edit, and View menus
listed first, The File menu in-
cludes options such as Save
and Open File..., the Edit menu
has items such as Undo, Copy,
Paste, and Select All, while in
the View menu you'll find view-
ing options such as changing
the layout of open windows.
{4) menu bars have the Edit
menu has items such as Undo,
Copy, Paste, and Select All.
{4) Direct access is a storage
method that allows the com-
puter to locate and read a par-
ticular record without having
to search through an entire file.
The computer is able to access
data independent of its loca-
tion. Magnetic disks, diskettes,
and drums are considered direct
access devices.
(1) Utllity programs, commonly
referred to as just “utilities,” are
software programs that add
functionality to your computer
or help your computer perform
better, These include antivirus,
‘backup, disk repair, file man-
agement, security, and network-
ing programs. Utilities can also
be applications such as
screensavers, font and icon
tools, and desktop enhance-
ments. Utility software, which
helps to analyse. configure, op-
. timize and maintain the com-
puter.

14.

15.

16.

20.
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